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Introducing CorelDRAW® Graphics Suite 2017

Our best just got better — CorelDRAW® Graphics Suite
2017 is our latest and most innovative release yet.
Following the introduction of the industry-acclaimed
CorelDRAW Graphics Suite X8 in early 2016, this new
version has been developed with an eye on rapidly
evolving technologies and an ear to customer feedback.
Thanks to an accelerated development cycle, users can
leverage the latest hardware, peripherals, and operating
systems to craft and personalize projects and deliver
expert results in record time.

The technology that drives so much of the design world
is evolving at an astonishing rate. CorelDRAW Graphics
Suite 2017 lets you fully leverage these advancements.
Design with ease using some of today’s latest
technology, including your stylus or touch-enabled
devices, the Microsoft Surface Dial, Ultra HD 5K monitors
and more. No matter which new tools and accessories
are essential to your workflow, CorelDRAW Graphics
Suite 2017 is here to help you make the most of your
investment.

Jump in

Whether you're a first-time user or an experienced
designer, CorelDRAW Graphics Suite 2017 makes it easy
to get started. Learn the basics or see what's new with a
Startup tour, and be productive immediately with a
workspace that matches your workflow needs. There's a
range of high-quality content and versatile in-product
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learning resources to enrich your projects. You can also
take advantage of the latest that Windows 10 has to
offer, together with multi-monitor viewing and 5K-
display support.

Craft

CorelDRAW Graphics Suite has long been a favorite with
creative and production professionals because the
unparalleled power of its toolset allows them to design
with dexterity, speed, and confidence. With this new
release, we're going further by challenging assumptions
and looking at creativity in a way that's never before
been possible in vector graphics.

What if you could create hand-drawn and organic vector
shapes as easily as putting a pen to paper? Imagine your
best and most creative ideas starting out as sketches
right on your screen — forget about that notebook,
napkin or white board. The tactile, hands-on experience
that artists love about raster painting has now been
incorporated into your creative vector workflow.

CorelDRAW Graphics Suite 2017 introduces a
revolutionary new tool, LiveSketch”, that uses the power
of neural networks to understand and deliver a natural
and creative vector drawing experience in real time.
Based on the latest research on Artificial Intelligence and
Machine Learning, LiveSketch allows you to transform
the creativity of free-form sketching into precise vector



curves directly on a pen-enabled device. Your strokes
are intelligently interpreted, adjusted and combined with
existing vector curves, allowing you to sketch and design
on the fly. LiveSketch turns the vector graphics creative
process on its head. For the first time, you no longer
need to think about the math behind the curve to bring
your ideas to life.

Our team created the LiveSketch tool by studying how
artists apply strokes by hand, such as the use of
overlapping strokes, folded lines and even chicken
scratches, to draw the shapes they want. We then
developed CorelDRAW to interpret and represent these
strokes to create the object the user is trying to achieve.
LiveSketch removes barriers to creativity by relieving you
from thinking of your designs in terms of vector shapes,
lines and nodes. Not only does it offer an enjoyable,
spontaneous and natural drawing experience, but it also
brings a new tactile dimension to a vector-based
environment. Shapes now respond to the user in ways
that were never possible before. Almost clay-like, these
vector shapes are malleable and organic.

This revolutionary change is freeing and fun, plus it also
eliminates the time-consuming task of starting a design
on paper, and then needing to scan, trace or recreate it
in vector. We believe the LiveSketch productivity boost
will be a must for any graphics professional and can't
wait to see what our users create with it.

Of course, there will be times when you'll want to
continue working in a traditional vector workflow. To
keep you working quickly, CorelDRAW Graphics Suite 2017

also offers faster, more efficient object editing and
intuitive node manipulation. Nodes, interactive handles
and vector previews have been revamped to ensure that
they won't get lost in the background colors of your
design. What's more, each node type is assigned a
unique shape, so you can quickly identify cusp, smooth,
and symmetrical nodes.

If you work with a stylus or on a touch-enabled device,
CorelDRAW Graphics Suite 2017 delivers a range of
creative possibilities. You can take advantage of a
number of real-time stylus input factors or sketch on the
fly and make quick adjustments using touch or a stylus
with Tablet Mode support and the new Touch
workspace.

Personalize

For every industry that relies on CorelDRAW Graphics
Suite, there's a different workflow, each with different
needs. Rather than force anyone to work a certain way,
Corel encourages you to work in whatever way best suits
you and your projects.

We know how critical your custom workspaces are to your
productivity. That's why CorelDRAW Graphics Suite 2017
gives you the ability to reuse CorelDRAW and Corel
PHOTO-PAINT workspaces that were created in versions
X6, X7, and X8, so you can continue designing right
where you left off. What's more, you have the flexibility
of importing select workspace elements into your
current workspace, or creating a totally new Ul setup.
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You can adapt node shapes to best suit your way of
working and new color personalization options help you
edit objects more efficiently by letting you choose the
colors for nodes, handles and previews that will stand
out against underlying colors. There is also a range of
customization options to help you tailor the interface to
suit your workflow. Because fonts are central to so many
creative sectors, the Corel Font Manager” simplifies
finding and managing fonts on your system. You can
also enhance and tailor your workflow even more by
choosing from a collection of creative tools available for
download or purchase directly from within the suite.

Delight

CorelDRAW Graphics Suite 2017 has everything you
need to deliver eye-catching professional-quality
designs to any medium. Whether your work is destined
for the web, social media, print ads, brochures,
billboards or signs, the suite provides the flexibility and
accuracy that you need for all types of projects.

One of the reasons that CoreIDRAW Graphics Suite has
long been a favorite with creative professionals is that it
has always allowed them to focus on wowing their
audience. But time spent tweaking color settings and
dealing with file formats can come at the expense of
what they'd really rather be doing — creating expressive,
captivating designs. To that end, CorelDRAW Graphics
Suite offers a color-management system that assures
accurate color representation regardless of your level of
expertise. Whether you're importing a client’s mock-up,
working with previous designs, or sending a project to a

Reviewer's Guide [ 4]

print shop or manufacturing facility, you can be certain
that your colors are true. And with its industry-leading
file format compatibility, CoreIDRAW Graphics Suite
2017 provides the flexibility that designers need for
sharing their work. There’s also a web-development tool,
Corel® Website Creator”, that has dozens of templates
so you can easily design, build, and maintain a web
presence without having to learn how to code.

And when you could use some inspiration or advice,
there's the CorelDRAW Community site. It's the place
where users can get together to share and learn from
others, discover what community members create, and
fuel their inspiration.



Choose your purchase option

In the interest of user choice, we're offering several
CorelDRAW Graphics Suite purchase options.

Perpetual License

At Corel, we strongly believe that you should not be
forced into a rental model if you don't want it. For a one-
time payment, a CorelDRAW perpetual license gives you
the right to use the software forever, with no extra
monthly cost. By purchasing a box, download version or
volume license version of the product, you get access to
the full benefits of a specific version, and there is no
need for a permanent Internet connection. Perpetual
licenses give you the option to pay for future major
upgrades, only if you want them.

Subscription

A CorelDRAW® Subscription is an affordable way to stay
up-to-date with the latest tools and enhancements of
CorelDRAW Graphics Suite. It offers a cost-effective
alternative to paying the upfront cost of the software.
Instead, you'll get a full, downloadable version of
CorelDRAW Graphics Suite” that remains entirely
functional for as long as your subscription is active. You
decide how and when you want to use it. An annual plan
offers an overall discount, with the option to auto-renew
or end your subscription after the 12-month period.

Your subscription entitles you to the latest performance
enhancements and updates. It also entitles you to the

next major version upgrade for as long as your
subscription is active.

Upgrade Program

The CoreIDRAW® Upgrade Program is the hassle-free
way for designers to keep their toolbox up-to-date at
the best price. If you own a version of CoreDRAW
Graphics Suite with a perpetual license, you pay one
affordable fee once a year, and you're assured of
working with the latest design tools, new file
compatibility, and the most current technology. And as
long as your account is active, you'll automatically get
the latest version of CoreIDRAW Graphics Suite. Best of
all, sign up once and forget about it. In addition, if your
needs change, you will continue to own the last version
you received through the upgrade program.

"A corel.com account and Internet connection are required to download
and use the application and manage your subscription.
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Customer profiles

Graphics and creative professionals

Graphics and creative professionals in industries
including advertising and printing spend much of their
time creating and editing graphics, working with text,
and retouching photos. These users frequently work on
layout and design projects for print and the web, such as
creating logos and multipage brochures. Some work as
illustrators and fine artists, combining classic art
practices and time-honored techniques with state-of-
the-art vector-illustration technology. They seek
innovative design tools that optimize their workflow and
compatibility with commonly used file formats.

Production professionals

These users focus primarily on sign making, screen
printing, engraving, and graphic design for print and the
web. They frequently repurpose and combine such
assets as illustrations, scanned logos, photos, clipart
images, and fonts. They have to repurpose content
provided by clients in a variety of formats. They use this
as a starting point, but spend the bulk of their time
reworking and tweaking it. They pay particular attention
to design optimization and output preparation. Their
work is output to large-format printers, engraving
machines, glass or vinyl cutters, and silk-screen or Direct
to Garment (DTG) printers.
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Occasional graphics users

Entrepreneurs and small to medium-sized businesses
often create marketing and communications materials
in-house. Typically self-taught in graphic design, these
occasional users modify existing artwork, retouch
photos, and create ads, flyers, and other marketing
collateral.

Business users in medium-sized to large enterprises
strive to create professional, graphically rich projects
ranging from sales presentations to web graphics. They
spend considerable time reworking existing projects and
retouching photos to use in their marketing and
communications materials.

Hobbyists are self-taught and use graphic design
software occasionally for creative projects — such as
newsletters, calendars, banners, and photo layouts — for
personal or community use.



Why do graphics professionals choose
CorelDRAW Graphic Suite?

There are many reasons why CorelDRAW Graphics Suite
is the software of choice in so many industries, but two
really stand out: unparalleled typographical features and
the ability to fine-tune your work environment with
customization options and the support for the latest
technology.

Typography

Whether your work is destined for the web, a digital
sign, a billboard or print, chances are text will be a
critical part of the design. Text is such an important
element of a project because it can truly set the tone. A
font or text style chosen haphazardly can undermine an
otherwise great piece of work, running counter to the
rest of a design.

CorelDRAW Graphics Suite simplifies your typographic
workflow by allowing you to manage your font
collections and create new ones, choose the perfect font
for a project, refine the look of text until it's just right,
and ensure that there are no problems when handing off
work for printing. CorelDRAW Graphics Suite 2017 offers
Corel Font Manager, a standalone font management
application for finding, organizing, and previewing local
fonts. It also provides easy access to online fonts on the
Content Exchange. One of the typographical features
that's made the suite a favorite with graphics and

production professionals is intuitive searching and
filtering that helps you quickly find fonts for any project.

The Insert Character docker helps you quickly find a
font's available glyphs, while the Font Playground lets
you easily find the perfect font by comparing and
adjusting a variety of text examples. Font embedding
ensures that CorelDRAW documents can be viewed,
printed, and edited exactly as designed. You can also
access and preview advanced OpenType features for
your fonts, including strong support for Asian text.

Flexible Ul customization

When it comes to giving you the freedom to modify
your workspace to your exacting standards, few
applications come close to CoreIDRAW Graphics Suite.
Giving you the ability to design in a personalized
creative environment has always been a hallmark of the
suite. There are endless customization options that let
you keep frequently used tools within easy reach and
tailor the main applications to work the way you prefer.
Quick Customize buttons make workspace
customization fast and easy. What's more, graphics
professionals can reuse legacy CorelDRAW and Corel
PHOTO-PAINT workspaces that were created in
versions X6, X7, and X8 in a few simple clicks.

You can tailor the shape, size, and color of nodes to
best suit your workflow and customize the colors of
handles and previews so they stand out against the
background of a project. Icons can be scaled up to
250%, allowing you to get more out of high-resolution
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displays. The color of the desktop, toolbars, and window
borders can also be personalized to best suit your
projects. What's more, CorelDRAW has a variety of
workflow-specific workspaces based on the
recommendations of professional industry experts who
use the suite routinely to arrange tools and features for
specific tasks.

The suite is optimized for high resolution displays,
ensuring that user interface elements appear crisp and
legible when displayed on high resolution monitors,
including UltraHD 5K. Advanced multi-monitor
support ensures that designers can work in CorelDRAW
and Corel PHOTO-PAINT across multiple monitors of
varying DPI.
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What's included?

Applications

CorelDRAW® 2017: This intuitive vector-illustration
and page-layout application meets the demands of
today’'s busy graphics professionals and graphics
non-professionals.

Corel® PHOTO-PAINT® 2017: This professional
image-editing application lets you quickly and easily
retouch and enhance photos.

Corel Font Manager™ 2017: This standalone font
management application lets you find, organize, and
preview local fonts, as well as online fonts on the
Content Exchange.

Corel® PowerTRACE® 2017: This utility is embedded
in CorelDRAW to help you quickly and accurately
convert bitmaps into editable vector graphics.

Corel® CONNECT™ 2017: This full-screen browser
lets you access the suite’s digital content, the
Content Exchange, and search your computer or
local network to quickly find the perfect
complement for a project.

Corel CAPTURE™ 2017: This one-click utility lets you
capture images from your computer screen.

Corel® Website Creator"”: This application offers a
fast and easy way to design, build, and manage
websites.
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Supporting applications

Barcode Wizard: This wizard guides you through
the generation of bar codes in a wide range of
industry-standard formats.

Duplexing Wizard: This wizard helps you optimize
your projects for two-sided printing.

PhotoZoom Pro 4: This plug-in lets registered users
export and enlarge digital images from Corel
PHOTO-PAINT.

WhatTheFont: This online font identification service
is integrated with CorelDRAW.

Microsoft® Visual Basic® for Applications 7.1: This
integrated development environment includes 64-
bit support and helps you streamline your workflow
by automating tasks.

Microsoft® Visual Studio® Tools for Applications
2015: This toolset includes the power of the .NET
framework, so you can create time-saving macros to
automate tasks and extend functionality.

GPL Ghostscript: This feature lets you isolate and
use individual elements of imported EPS files rather
than only header images. It also improves the
import of PDF files generated by third-party
applications.

*  Application download requires Internet connection and
an authenticated version of CorelDRAW Graphics Suite.



Content

10,000 clipart and digital images

2,000 high-resolution digital photos

Over 1,000 TrueType and OpenType® fonts
350 professionally designed templates

2,000 vehicle templates

Over 500 interactive frames and photo frames

Over 600 fountain, vector and bitmap fills

Documentation

Quick Start Guide
Quick-reference card

Help files

Training

Interactive Startup tours

Insights from the Experts

Hints docker

Discovery Center access from the Welcome Screen
More than 5 hours of training videos

Video Hints

Tips & Tricks

Minimum system requirements

Windows 10, Windows 8.1, or Windows 7 (32-bit or
64-bit editions), with the latest updates and service
packs

Intel Core i3/5/7 or AMD Athlon 64
2 GB of RAM
1 GB of hard disk space

1280 x 720 screen resolution at 100% (96 dpi), 1920 x
1080 at 150%, and 2560 x 1440 at 200%

DVD drive for installation by disc
Multi-touch screen, mouse, or tablet
Microsoft .NET Framework 4.6
Microsoft Internet Explorer 11 or higher

An authenticated version of CorelDRAW Graphics
Suite and Internet connection are required to access
online features and content included with your
software. You can authenticate the product after the
suite installation, before starting an application, or
while using an application. The product can be used
offline if you connect to the Internet at least once a
month to validate your software license.
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Top new and enhanced features

CorelDRAW Graphics Suite 2017 is an intuitive and
complete graphics solution that empowers you to make

a major impact with your artwork. \—f\

Design using hand-drawn vector curves right from the
get-go with the LiveSketch tool. Harness the creative
possibilities of a number of real-time stylus input factors.
Sketch on the fly and make quick adjustments using
touch or a stylus with Tablet Mode support and the
Touch workspace. Edit objects and effects more
efficiently using enhanced previews, nodes, and handles
that don't get lost in the background colors of your
design. Import CorelDRAW and Corel PHOTO-PAINT
workspaces that were created in versions X6, X7, and X8.

New! LiveSketch™ tool: This revolutionary tool uses an
Artificial Intelligence technology called a neural network
that gives users an entirely new way to bring their vector
designs to life. LiveSketch is perfect for kick-starting a
project and getting the idea in your imagination onto
the screen in front of you. Great when working with a
stylus or on a touch-enabled device, it combines the
speed of sketching with flexible stroke-adjustment
controls so you can begin your design concepts using

hand-drawn vector curves right from the get-go.

Whether you have great sketching skills or you are just
learning to sketch, CorelDRAW can adjust your strokes and
help you quickly move your ideas from imagination to reality.
Artwork by Andrew Stacey.
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The LiveSketch tool lets you capture design concepts
using hand-drawn vector curves. If you've ever used a
scanned sketch as the basis for a project, you'll quickly
see the creative and time-saving possibilities that the
LiveSketch tool offers. Not only does it eliminate the
need to scan and trace a drawing, but it also gives you
total control over how your strokes are adjusted and
converted to curves. Intuitive settings let you easily fine-
tune how CorelDRAW 2017 meshes with your sketching
cadence.

Strokes before (top) and after (bottom)
stroke adjustment: discrete overlapping strokes (left),
folded strokes (middle), chicken scratch (right)

Strokes created with the LiveSketch tool are adjusted
and added to existing curves based on the time and
distance between them. You can set the time it takes to
activate stroke adjustment after you've stopped drawing
and the distance at which strokes are automatically
added to existing curves.

/

With the timer set to 0 milliseconds (left), successive strokes
are converted into discrete curves. With the timer set to 1
second (right), successive strokes are joined into a single curve.

N

> » =

An existing stroke (left); A new stroke (in blue) is created within
the proximity of the existing stroke (middle). The existing stroke
is extended and readjusted (right).
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Disable proximity-based stroke grouping
to keep your strokes as separate objects.

You also have the option of combining all strokes drawn
within the specified time frame into a single curve,

regardless of the distance between them.
—

An example of an object created from
strokes joined into a single curve.

=5

If you want to extend an existing curve, simply hover
over it until it turns red and continue to sketch. The
subsequent stroke is seamlessly added to the existing
curve, allowing you to sketch, adjust and edit on the fly.
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When you move the pointer inside the editable area
of an existing curve, the curve is highlighted
to indicate that you can modify it.

When you include an existing curve into a sketch, the
resulting curve inherits the properties of the existing
curve.

A curve created with the Artistic Media tool (left). The new
stroke drawn with the LiveSketch tool is within the proximity
threshold of the existing stroke (middle). The resulting stroke

takes on the properties of the existing curve (right.)

Regardless of your sketching experience, you'll be
amazed how quickly you can produce impressive results.



In no time, you'll be capturing an inspiration or an idea
just as you had imagined it.

Give it a try
& ) Using the LiveSketch tool

1 In the toolbox, click the LiveSketch %’ tool.

2 On the property bar, do any of the following:

«  Move the Timer slider to set a delay before
your strokes are adjusted.

By default, the delay is 1 second. The minimum
delay is 0 milliseconds; the maximum is 5
seconds. Setting a longer delay period gives
you more time to manipulate your lines.

+  Click the Create single curve E button on
the property bar to allow input strokes to be
converted into one continuous line.

For best results, set a longer delay time.
CorelDRAW processes only strokes that are
within the specified delay time.

«  Type a value in the Curve smoothing box on
the property bar.

Higher values produce smoother curves.
3 Sketch in the document window.

You can readjust an existing curve by clicking
the Include curves button on the property bar

@, moving the Distance from curve slider to
set the distance at which existing curves are
included into a sketch as new input strokes, and
sketching over an existing stroke to modify it.

To see a stroke preview, click the Preview

mode % button on the property bar.

New! Stylus tilt, bearing, and rotation: CoreDRAW
Graphics Suite 2017 makes it easier than ever to get the
most out of your stylus and harness the creative
possibilities of a number of real-time input factors. A
redesigned Ul gives instant access to relevant controls
and the ability to quickly choose which stylus properties
to leverage.

In CorelDRAW 2017, the new Expression mode of the
Artistic Media tool lets you use pressure, tilt, and bearing
to vary brushstrokes.

The Expression mode of the Artistic Media tool lets you take
advantage of the pressure, tilt, and bearing of your stylus.

Powerful editing flexibility makes it simple to perfect
anything that you've drawn with a stylus. You can use
the property bar to precisely fine-tune an existing curve,
or you can use the Shape tool to adjust only a segment
of the curve by dragging nodes, but still retain all the tilt
and bearing values used when it was created. You can
get more out the Eraser tool by controlling the width,
flatness, and rotation of the nib with your stylus. You can
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also dictate bearing and tilt values before using either
tool to set a brush nib of fixed flatness and rotation.

Stylus support has also been enhanced in Corel PHOTO-
PAINT 2017. You can take advantage of pressure,
bearing, tilt, and rotation for the touch-up tools, Effect
tool, Eraser tool, and a number of brush tools. What's
more, you can pump up rotation, flatness and
elongation settings to get an even greater range of
artistic possibilities.

- T ——

Increased support for real-time input factors
lets you get more out of your stylus.

New! Touch-friendly Ul: Tablet Mode support makes it
easy to sketch on the fly and make quick adjustments
using touch or a stylus. The new Touch workspace,
activated when switching to Tablet Mode, streamlines
the Ul to maximize the size of the drawing window by
displaying only the tools and commands that you're
most likely to use in the field on a tablet. All other
features are still accessible in a couple of taps. And when
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you reattach the keyboard, the Ul reverts to the default
desktop setup. If you prefer working with one of the
desktop workspaces when you're in Tablet mode, you
can choose whatever Ul configuration works best for
you. Users can now also save time and work faster by
panning and zooming in a single gesture.

The Touch workspace offers a touch-friendly
environment with access to all the essentials.

Give it a try
Using touch

On Windows 10, Tablet mode is activated when you
detach a tablet from its base. CoreIDRAW
automatically switches to the Touch workspace when
Tablet mode is enabled.

Automatic workspace switching is not available for
Windows 8 or Windows 7. To switch to the Touch
workspace, you must choose it manually by clicking
Window » Workspace » Touch » Touch.



The Touch workspace is ideal for field work and
sketching by offering a streamlined user interface
(Ul) that shows you only the tools and commands
that you are most likely to use. In addition,

buttons and other Ul elements are bigger to
be touch-friendly.

the toolbox is modified to include only tools
you are likely to use often, as well as Undo,
Redo Copy, Paste, and Delete commands.

you can access menu commands by clicking
the Menu button in the lower-left corner of
the status bar.

the status bar lets you quickly change the
zoom level as well as access commonly used
commands and dockers.

You can use the following gestures:

to scroll in a document, tap the screen with
two fingers and drag in the direction you want
to scroll.

to zoom, pinch outwards to zoom in and pinch
inwards to zoom out using two fingers.

to pan and scroll simultaneously, pinch
outwards or inwards while dragging in the
direction you want using two fingers.

to choose a tool in a toolbox flyout, tap a
flyout button, and tap the tool you want.

New! Microsoft Surface Dial support: If a Microsoft
Surface Dial is part of your workflow, CorelDRAW 2017
offers native support to give you a greater range of ways
to create and interact with technology.

The Surface Dial can help you zoom in and out
as well as undo actions while you're designing.

Enhanced! Windows 10 support: Thanks to our
relentless pursuit of delivering the highest quality user
experience, CorelDRAW Graphics Suite 2017 is fully
compatible with and certified for Windows 10. Corel
delivers enhanced reliability and performance, so users
can maximize their productivity when working on the
world's most popular operating system.

Enhanced! Support for UltraHD 5K displays: An
updated interface and support for 5K monitors means
that creative professionals can comfortably view
CorelDRAW and Corel PHOTO-PAINT on even the most
high-definition monitors, including UltraHD. This allows
you to edit photos at their native resolution and see the
subtlest details in the image. And with more pixels
available, several windows can be opened side-by-side
for an efficient workflow.
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Enhanced! Advanced multi-monitor support:
Support for Per-Monitor Ul scaling and improvements to
multi-monitor support allow graphics professionals to
take advantage of the sharpness and fidelity of new
High-DPI monitors and laptops while still using lower-
DPI monitors to maximize design space (requires
supported hardware and Windows 8.1 or later). This
ensures that Ul elements scale properly and appear crisp
and legible on screens of all resolutions. For example,
you can drag a document out of the application window
and place it within a second screen, dedicating one
monitor to a drawing or image and the other to
frequently used dockers and toolbars.

Enhanced! Real-Time Stylus (RTS) support: You can
use your RTS-compatible pen tablet or device to capture
whatever inspires you on the fly. Support for the
Windows Real-Time Stylus delivers truly responsive
pressure sensitivity and tilt and gives you full control of
your brushstrokes in CorelDRAW and Corel PHOTO-
PAINT. What's more, there’s no stylus driver to install, so
you can get to work right away.

You can use your RTS-compatible device
to control your brushstrokes.
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Give it a try

Using an RTS-compatible stylus with
CorelDRAW 2017

In CorelDRAW 2017, click Tools P Options.

In the Global list of categories, click Pen Settings.
Enable the Real-Time Stylus option.

When you use a pressure-sensitive stylus or pen
tablet, the amount of pressure that you apply
controls the width of your strokes. Each person uses
a different pressure level in a stroke, and you can
set CoreDRAW to match your stroke strength by
specifying pen settings.

Proper pen settings are particularly useful if you
have a light touch. If a light stroke leaves no trace,
adjusting pen settings can increase sensitivity for
specific tools.

Using your stylus or digital pen, apply at least three
strokes in the window in the Pen Settings page,

building from the lowest to the highest pressure.

In the toolbox, click the Artistic Media tool (1)

click the Expression button é@ on the property
bar, and apply a few brushstrokes in the drawing
window.

You can also use the pressure of your pressure-
sensitive pen with the Eraser tool 5 Smear tool
2t Twirl tool @), Attract tool [}, Repel tool [{,
Roughen tool ¥, or Smudge tool ).



Enhanced! Vector previews, nodes, and handles:
CorelDRAW Graphics Suite 2017 simplifies shaping
curves and objects with redesigned nodes and handles
that are easier to see and manipulate. Enhanced vector
previews help you edit more efficiently by ensuring
nodes and curves stand out against background colors
in your design.

Enhanced previews, nodes, and handles
don't get lost in background colors.

New! Prominent interactive sliders: It's easier than ever
to work with object fills, transparencies, blends,
extrusions, drop shadows and more thanks to enhanced
interactive sliders that are more visible.

lorem Ipsu

Prominent interactive sliders simplify working
with object fills, transparencies, and more.

New! Custom node shapes: CoreIDRAW 2017 simplifies
shaping curves and objects by assigning each node type
a unique shape, making it easy to identify smooth, cusp,
and symmetrical nodes. Designers can tailor the look of
nodes to best suit their workflow or project with new
options for customizing their shape, size, and color. They
can also accelerate modifying elements in designs by
choosing to show the direction of curves and using a
range of drawing tools to edit nodes.

¥

Each node type is assigned a unique shape,
making it easy to identify.

New! Custom colors for previews and curve editing:
New color personalization options help you edit objects
more efficiently by letting you choose the colors for
nodes, handles and previews that will stand out against
underlying colors, making them easier to see.

You can choose custom colors for nodes, handles, and previews.
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Give it a try
& ) Using revamped node-editing features

1 In CorelDRAW 2017, click Tools P Options.

2 In the Workspace list of categories, click Nodes
and Handles.
3 In the General Settings area, you can make any of

the following node customizations:

+  To change the node size, choose an option
from the Node size list box.

+  To change the shapes of nodes, choose a node
shape from the Node shape list boxes for
each node type: cusp, smooth, and
symmetrical.

4 In the Colors area, choose Custom from the Color
scheme list box to create a custom color scheme
for nodes, handles, and previews:

*  Open the Main color picker, and choose the
color to be used in nodes and handles when
an object is selected for editing. When you
select multiple objects for editing, the main
color is used for the nodes and handles of the
first selected object.

*  Open the Secondary color picker, and choose
the color to be used in nodes and handles
when additional objects are selected for
editing with the Shape tool or when you are
editing vector effects such as extrusions.

You can display each node type in a different color
by enabling the Show node types in different
colors check box. You can also invert the colors of
nodes, handles and previews when displayed
against colored background by enabling the Invert
node and vector preview colors check box.
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New! Import legacy workspaces: CoreIDRAW Graphics
Suite 2017 lets you reuse CorelDRAW and Corel PHOTO-
PAINT workspaces that were created in versions X6, X7,
and X8. You have the flexibility of importing some
workspace elements and excluding others. You also have
the option of adding them to your current workspace or
creating a totally new Ul configuration. And choosing
which workspace elements to import or export is faster
than ever.

Import Workspace x

Select the workspace elements that you want to impert.

A

¥ Application Settings
¥| Dockers

¥ Menus

¥/ Shortcut Keys

| Status Bar
¥|Toolbars

-

-

Import selected workspace elements into:
Current workspace
® New workspace

Name:

Lorem

Base om:

Default -

Description:

Loremn ipsum dolor sit amet, consectetur adipiscing elit. Aliquam molestie
odio ut massa vehicula viverra, Mulla a enim massa.l

Import Cancel

You can import workspaces that were
created in versions X6, X7, and X8.
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CorelDRAW® Graphics Suite user favorites

CorelDRAW Graphics Suite users continue to enjoy many . .
of the following features that have been cornerstones of (’) Give It a try

the suite for years. Taking an interactive tour

Jump in 1 Click the Welcome Screen tab.

With a variety of in-product learning resources, it's easy If the Welcome Screen is not active, click Window

for first-time users or experienced designers to jump in
and quickly get started with CorelDRAW Graphics Suite. 2 On the Getting Started page, click Tour New
Features in the Take a Tour area.

» Welcome Screen.

Interactive Startup tours: You can get to work fast
and efficiently thanks to a series of interactive Startup
tours. Whether you are new to graphics software, an
experienced user, or someone familiar with other
graphics applications, there’s a start-up tour to help you
quickly get up to speed and take full advantage of the
features and tools of CoreIDRAW Graphics Suite 2017.

You can also launch this tour by clicking Help »

Take a Tour P Tour New Features.

This tour is designed for users who are familiar with
earlier versions of CorelDRAW Graphics Suite.
When you start a tour, a sample drawing opens
automatically. The steps in the tour are directly
related to design elements in this file.

As you complete a stage of a tour, you can move to
the next step by clicking Okay!. You can also
navigate to a specific step in the tour by clicking
the step’s corresponding button at the bottom of
the tour window.

If you want to pause a tour, click Quit, and click Yes

in the dialog box that asks you if you want to save

the results. To resume the tour, click the tour title,

You can learn the basics, see what's new, and click Continue Progress in the dialog box that
or transition to the suite. appears.
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Hints docker: The Hints docker is a hub of valuable
learning resources designed to help reduce the learning
curve for new users. It dynamically displays context-
sensitive information on the currently selected tool and
provides links to related information. The Hints docker
gives quick access to additional resources, such as video
hints, longer videos and written tutorials, so users can
learn more about a tool or feature without having to
search.

=T 18

The Hints docker makes it easy to get up and running quickly.

Product Details page: The Product Details page in the
Welcome screen is your one-stop source for the latest
on the suite and your user account. It provides
important information about your product or
subscription, account status, product updates, and the
Upgrade Program.

User guides available as eBooks: The CoreIDRAW
2017 User Guide and Corel PHOTO-PAINT 2017 User
Guide are available as eBooks. Published to the EPUB
and MOBI file formats, the eBooks bring the most
comprehensive information about product features to

your eBook reader. Following the user guides on an
eBook reader saves you switching between program
windows on your system, allows you to keep learning on
the go, and ensures access to the suite’s Help files when
you don't have Internet access. To access an eBook, sign
in to your corel.com account, and click Downloads on
Your Account page.

Craft

Make the most of your design dexterity with the high-
caliber, yet intuitive, features of CorelDRAW Graphics
Suite 2017.

Hiding and displaying objects: CorelDRAW 2017 lets
you hide objects and groups of objects so that only the
sections you want or need to see in a project are
displayed. When working with complex designs, the
ability to hide a particular element in your drawing can
be a great time-saver. It ensures that you don't
inadvertently select and edit an object that you hadn't
intended to work on, and it lets you experiment with
your designs more easily.

Object Managor

g )

sabwury Dl g5

You can hide individual objects or groups of objects
on a layer without hiding the entire layer.
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Splitting objects: With the Knife tool, vector objects,
text and bitmaps can be split along straight, freehand or
Bézier lines. You can create a gap between the split
objects or have them overlap. There are also options to
convert outlines into curve objects that can be
manipulated or keep them as outlines. And if you're
unsure, CorelDRAW can eliminate any guesswork by
automatically choosing the option that best preserves
outline appearance.

The Knife tool lets you split vector objects, text,
and bitmaps along any path.

(!) Give it a try

Splitting objects with the Knife tool

1 In CorelDRAW, click File » New.

2 Create a couple of shapes using the Ellipse tool
(press F7) or the Rectangle tool (press F6), and
click colors on the color palette to apply fills to the
shapes.
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3 In the toolbox, open the Crop tools flyout, and click
the Knife tool §.

4 On the property bar, choose a split mode.

-Poi i +
You can choose 2-Point Line f Freehand b
or Bézier " mode.

5 On the property bar, choose an outline option.
You can choose to convert lines to curves, keep
them as outlines when splitting objects, or let
CorelDRAW choose the option that best preserves

the outline appearance.

You can create a gap or an overlap between the
new objects by choosing an option from the Cut
span list box on the property bar. You can set the
size of the gap or the overlap in the Width box.
You can close the paths that result from splitting an

object by clicking the Auto-close on cut button mD.

6 Drag across the objects to split them.

Corel Font Manager: When the number of fonts on
your system become less of a benefit and more of a
hassle, Corel Font Manager is the answer. It lets you
easily handle, organize, and explore your typeface and
font collections by giving you the tools to control every
aspect of your typography workflow. Whether you want
to find fonts for your projects, organize fonts for easy
access, or manage unneeded fonts, Corel Font Manager
has the tools you need. It lets you access online fonts
from the Content Exchange, which can be installed or
downloaded to use later. You can browse and search



online and local fonts, preview font glyph sets, add

) Corel Font Manager, a standalone font-
custom font collections, and more.

management application, opens.

When you add folders and create collections, all your 2 InCorel Font Manager, click Content Exchange in
fonts, including ones that aren't installed, become the Libraries pane to display online fonts that are
accessible from the Font list box in CorelDRAW and provided by Corel and are available for download.
Corel PHOTO-PAINT. This means that you can use fonts 3 Type Humanst in the Search box.

that are not installed in your drawings and documents. Fonts that match this search term appear in the

In addition, any collections that you create appear as Preview pane.

font filters in the Font list box of the main applications,
so fonts can be filtered to show only the ones included

) . ) Font list box: Finding the right font for your project is
in specific collections.

easy in CorelDRAW and Corel PHOTO-PAINT. Using the
Font list box, you can quickly view, filter, and find the

B Conel Fonn Manage 2017 053-Ba) T 0 D - 8 x
Prp— L LI e S _ specific font you need. Fonts can also be sorted based
o Academy Engraved LET (Plain, Nomal) ¥ o ¥
. Academy Engraved LET - : on weight, width, supported scripts, and more. In
Cortent Exchange. [ e 14 o .
o Agency FB (family) B e . addition, any folders or font collections added to Corel
Favoreer Symbels
e Fpeo———r—— : Font Manager are accessible from the Font list box in
Agency FB Bt A A )
O sarcyrs S R N CorelDRAW and Corel PHOTO-PAINT, allowing you to
Agency FB % & (I . . .
= B oy - o use fonts that are not installed in your drawings and
Aharoni /01 2 3 documents.
Alegreya (family) 4 5 6 T8
L 9 : ; & /
T adegeeys Ragular, norssal) 4?2 - A B
| Alegreya CNEF O

The Corel Font Manager simplifies exploring, organizing,
and managing your typeface and font collections.

. -@S’TIL . s m‘mﬂ"
(’) Give it a try = @ T

Searching for a font

1 Click the Application launcher button E on the
standard toolbar, and then click Corel Font The Font list box helps you quickly find the perfect font.

Manager.
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Special characters and glyphs: The Insert Character
docker presents all characters and glyphs associated with
a selected font, making it easy to find these items and
then insert them in documents. Available in both
CorelDRAW and Corel PHOTO-PAINT, the docker includes
a filtering option for displaying only specific character
subsets. For example, users can choose to display only the
Cyrillic characters for a selected font.

- - .
Insert Character
w
g
Shows the most recently used glyphs § -
g » /w ol .
H SE)
) Zapfino Extra LTX Pro v %
Entire Font vl ®
L] - -

aa Aa b

You can quickly find a font’s available characters
and glyphs by using the Insert Character docker.

Font Playground: In both CoreIDRAW and Corel
PHOTO-PAINT, the Font Playground docker offers an
easy way to browse, experiment with, and choose the
perfect font. You can easily add sample text to view its
appearance in different fonts, and a handy Zoom slider
lets you quickly adjust the size of sample text. With a
single click, the sample text can be displayed as a single
line, multiple lines, or a cascading series of increased
sizes. The Font Playground also provides access to
advanced features within OpenType fonts. If a text
sample uses an OpenType font, and the selected
characters have OpenType alternates, simply select the
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text to display the Interactive OpenType arrow and then
choose which features to apply.

Font Playground
O Vivaldi -

=0 M A
Lorem ipsum ...

- &Lorem psum *

111}
m
punoubide) jua4 7’

Liore 1l et Duis

Lorem ipsu...

&orem gpsum dolor.

Add another sample

Copy

With the Font Playground, you can easily find the perfect font
by comparing and adjusting a variety of text samples.

Font embedding: Users can embed fonts when saving
CorelDRAW documents so that recipients can view, print,
and edit the document exactly as designed. This is
especially useful when sending a CorelDRAW file to a
print shop, ensuring that the document can be viewed
and printed accurately.

CorelDRAW respects any restrictions encoded with each
font, so a font must support embedding to be saved with the
document. While some fonts cannot be embedded, most will
support embedding for either print and preview, or for
editing.

OpenType support for Asian text: While working
with Asian text, you can use advanced OpenType



typography features, such as widths, forms, vertical Copying curve segments: Another time-saver in

metrics, kana glyph alternatives, and vertical alternates CorelDRAW is ability to copy or cut a specific part of a curve

and rotation. segment. You can then paste it as an object, making it easy
to create new adjacent shapes with similar contours.

ABL @ Ot

« Character il |

Al senpty -i

/5% = )

A, Uniform Fill ~ Il - -
T HoFal i - }
A= vl [T

b X Q@ a8

-} - -,

A S

Curve segments can be reused by copying, pasting,
or duplicating pieces of existing curves.

Users can access advanced OpenType features for Asian text. Drop shadows with Gaussian Blur feathering: Drop

shadows are a great way to enhance elements in
designs. In CorelDRAW, users can create realistic drop
shadows that have natural-looking feathered edges in
an instant thanks to the Feathering direction button on
the property bar.

Selecting adjacent nodes: CorelDRAW offers node
selection that simplifies working with complex shapes.
You can select adjacent nodes on curves by using the
Shape tool while holding down Shift. You also have the
option of changing the direction in which the nodes are
selected.

You can select several adjacent nodes (left) and
change the direction in which the nodes are selected (right). You can adjust the feathering of drop shadow edges.
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QR codes: With CorelDRAW, designers can create
unique, artistic, and scalable QR codes by adding text,
colors, and images. Popular in consumer advertising and
packaging, QR codes give smartphone users quick
access to a brand's website, which can offer additional
product information. The Object Properties docker
makes it easy to customize a QR code, and object styles
can be created to save a fixed appearance for the QR
code, enabling quick and easy reuse.

You can change the shape, outline width, color, and fill
type of the QR code pixels, change the background
color and fill type, and more. The information included
in the QR code can be tailored, such as URL, email
address, phone number, SMS, Contact, Calendar event,
and Geo location. There's also a Validate option, which
analyzes the QR code to ensure it can be read by QR
code readers, smartphones, and scanners.

Object Properties

B Al ]

QR Code £ g
2

URL v X
]
=

http:/ fwww.coreldraw.com 5
&

gg¢ Uniform Fill  « - -

= Mo Fill v - wmn

i [Hione] - R T

@ =

% & - 4wt

Weld Pixels
g | High v (g 0%

4

CorelDRAW provides extensive
options for the creation of QR codes.
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Healing Clone tool: It's easy to ensure that your photo
subjects always look their best thanks to the Healing
Clone tool. It discreetly removes unwanted spots and
imperfections from an image by painting with sampled
texture and matching it to the color of the area that
you're retouching. In a few clicks, blemishes or scars can
be seamlessly repaired and blended into the rest of the
photo.

The Healing Clone tool helps you refine your
photos by painting with sampled texture.

(,) Give it a try

Fixing imperfections with the
Healing Clone tool

1 In Corel PHOTO-PAINT, open an image.
2 In the toolbox, open the Touch-up tools flyout, and
click the Healing Clone tool §¢’.

You can also activate the Healing Clone tool with a
keyboard shortcut by pressing 0.



You can adjust settings for the Healing Clone tool
to work with more precision. On the property bar,
you can set the nib’s size or shape, and specify the
brushstroke’s transparency or feathering.

You can also adjust the nib size on the fly by
holding down Shift and dragging.

3 Set a source point by clicking an image area that
contains the texture that you want to use to
retouch an unwanted area.

The source point brush is marked by a crosshair.
You can reset the source point by right-clicking any
area of the image.

4 As you move the cursor away from the source
point, you'll see the target brush, which applies the
sampled texture and matches it to the color of the
surrounding area.

5 Drag across the area that you want to cover.

The source point brush moves relative to the target
brush as you drag across the image. You can use
the same source point for subsequent brushstrokes
by holding down Shift+Alt as you drag.

Correcting perspective distortions: With the
Straighten Image dialog box in CorelDRAW and Corel
PHOTO-PAINT, users can correct perspective distortions
in photos that have straight lines and flat surfaces. In a
few clicks, you can easily fix photos of buildings,
landmarks, or objects that appear in the wrong
perspective or that were taken from an angle other than
directly in front.

I
| 1

You can quickly correct perspective distortions in photos.

(!) Give it a try

Correcting perspective distortion

1 In Corel PHOTO-PAINT, open an image.
2 Click Adjust P Straighten Image.

3 In the Straighten Image dialog box, move the
Vertical Perspective slider to the left until the
image appears as if it had been captured straight on.

4 To crop and resample the corrected image to its
original size, enable the Crop check box, and then
enable the Crop and resample to original size

check box.

5 Click OK.

Gaussian Blur lens: The Gaussian Blur special effect in
Corel PHOTO-PAINT is available as a lens, so images can
be blurred without overwriting the original image. When
you create a lens, the changes you make are non-
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destructive, so any edits are displayed on the screen
through the lens rather than applied to the image pixels.
The lens is created as a separate object on a layer above
the image background so you can edit the lens and the
background image separately, maintaining the original’s
data and quality.

You can blur an image without overwriting it.

(,) Give it a try

Applying a Gaussian Blur lens

1 In Corel PHOTO-PAINT, open an image.
2 Click Object » Create P New Lens.
You can also create a lens by clicking the New Lens

button in the Object Manager docker. If the
Object Manager docker is not open, click Window
» Dockers P Object Manager.

3 In the New Lens dialog box, choose Gaussian Blur,
and click OK.
4 In the Gaussian Blur dialog box, experiment with

the Radius slider.
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As you move the slider to the right, you increase
the blurring of the focus of the image according to
Gaussian distribution, which spreads the pixel
information outward using bell-shaped curves to
produce a hazy effect.

Planar Mask tool: The Planar Mask tool in Corel
PHOTO-PAINT lets you define a feathered editable area
along parallel lines. When combined with a blur effect,
this tool lets you simulate depth of field, giving focus to
a particular object while blurring areas outside the
planar mask. The effect of the planar mask can be
modified by moving or rotating the lines. You can also
use mask modes with the Planar Mask tool.

= X [ - e e

The Planar Mask tool lets you define a
feathered editable area along parallel lines.

Liquid tools: Corel PHOTO-PAINT has four pressure-
sensitive Liquid tools — Smear, Attract, Repel, and Twirl —
that offer creative options for retouching photos. These
tools let you reshape specific image areas to produce
unique artistic effects. Each tool responds to the pressure



of your digital pen or stylus, and provides options that
help you control the intensity of the effect.

With the Liquid Smear tool, you can push pixels around
an image area to produce distortion effects. The Liquid
Twirl tool produces twirl effects from image areas. The
Liquid Attract and Liquid Repel tools pull pixels toward or
push pixels away from an image area.

Corel PHOTO-PAINT includes pressure-sensitive Liquid
tools that provide creative options for retouching photos.

Interactive brushstroke transparency and
feathering: With Corel PHOTO-PAINT, you can use

modifier keys to interactively adjust the transparency and
feathering of brushstrokes. This lets you apply transparency
and feathering on the fly, and works with the Eraser, Red-eye
removal, Clone, Touch-up brush, Paint, Effect, Image
Sprayer, Undo brush, and Replace color brush tools.

I—|—A_n_|_|?

You can apply brushstroke transparency
and feathering interactively.

Special effects: Corel PHOTO-PAINT has a variety of
camera effects, such as Bokeh blur, Colorize, Sepia
Toning, and Time Machine to help you recreate historic
photographic styles and give your images unique visual
appearances.

With the Bokeh blur effect, you can define an area of
focus and leave the rest of the image out of focus. A
duotone image can be created using the Colorize effect
to replace all colors in an image with a single hue. The
Sepia Toning effect simulates a photo taken with sepia
film, which is similar to grayscale except with brown
tones. And with the Time Machine, you can choose from
seven historic photography styles ranging from 1839 to
the 1960s.

Corel PHOTO-PAINT provides camera effects to
help you create images with unique visual appearances.
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Personalize

CorelDRAW Graphics 2017 ensures that you feel right at
home with all of your favorite tools by giving you the
ability to adapt your design space to your needs.

Fully customizable Ul: CoreIDRAW Graphics Suite
2017 offers Ul customization options that allow you to
tailor your design space to create a unique work
environment. Icons can be scaled up to 250%, and
there’s a variety of colors for the application
background.

You can fully customize your design space to your needs.

Customizing desktop color: CoreDRAW Graphics
Suite 2017 offers flexible desktop color scheme options.
You can change the color of the area surrounding the
drawing page in CorelDRAW or the image in Corel
PHOTO-PAINT to set up the optimal environment for
each project, reduce the overall workspace contrast, or
increase the legibility of design elements.

Reviewer's Guide [ 36 ]

Customizing window border color: You can
customize the color of window borders in CorelDRAW
and Corel PHOTO-PAINT to match your personal
preference. If you use both applications simultaneously,
different border colors can be set for each, which lets
you quickly identify them when switching programs.

(,) Give it a try

Customizing the Ul

1 Click Tools » Options.

2 In the Workspace list of categories, click
Appearance.
3 In the Size area, move the slider to the right for

larger Ul items, and to the left for smaller Ul items.

The scaling level is relative to the scaling level of
the operating system. The default setting is 100%,
which means that Ul items in the application
appear the same size as similar Ul items in the
operating system. Scaling by 200% makes the
application Ul items appear twice as large as the Ul
items of the operating system.

4 In the Color area, choose an option from the
Theme list box.

To make the workspace lighter or darker, you can
choose one of the following themes: Light,
Medium, Dark, or Black.

5 To change the border color of the application
window and dialog boxes, open the Window
border color picker, and choose a color.

6 To change the color of the area surrounding the
drawing page, open the Desktop color picker, and
choose a color.



Status bar: You can place the status bar at the top of the
application window, making it easier to see useful information
about selected objects, such as color, fill type, outline, and
more.

Simple customization: The toolbox, docker space, and
property bars contain handy Quick Customize @
buttons, which will help you tailor the interface to suit
your workflow. Available in both CorelDRAW and Corel
PHOTO-PAINT, these buttons offer a fast and convenient
way to add dockers to your workspace, add or remove
tools from the toolbox, and add or remove items from a

property bar.
Property Bar @® 0w oA X
a0 S ~ -] Al a

| 4 Preset
~ | Brush
« K Sprayer
« & Ccalligraphic
+ & Pressure

+ af Preset Stroke List

+ Az Freehand Smoathing
1 width
fi] Scale Stroke With Object
3 Bounding Box

Reset toolbar

The Quick Customize buttons make
workspace customization fast and easy.

Get More docker: You can expand your collection of
creative tools by downloading applications, plug-ins,
and extensions directly from within CorelDRAW and
Corel PHOTO-PAINT. You can download your free license
of Corel Website Creator, purchase AfterShot Pro for the
ultimate RAW workflow, experience Corel ParticleShop
for amazing bitmap effects, and more.

Get Mare

Tools Content

siones g

Apps & Plug-ins

Fit Objects to Path

g} Place any number of objects ona
P path with one casy click.

Impact Tool

Create comic-book style effects.

52999
PhotoCocktail
Convert your designs into
powerful photographic mosaics.

=

The Get More docker lets you expand your collection of creative
tools directly from within CorelDRAW Graphics Suite 2017.

(,) Give it a try

Downloading apps and extensions from
within CoreIDRAW or Corel PHOTO-PAINT

Note: You must be online and signed in to your
corel.com account to download apps from within
the main applications.

1 On the standard toolbar, click the Search Content
button E to open the Get More docker.

2 Click the Tools tab.

3 Click Apps & Plug-ins, and click Corel Website Creator.

This application offers a fast and easy way to
design, build, and manage websites.

4 Click Download.
5 Click Extensions, and click Prep and Stretch.
6 Click Download.
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Prep and Stretch docker: One of the best ways to
show off a great photo is to print it on canvas. With the
Prep and Stretch docker in Corel PHOTO-PAINT 2017,
you can prepare your photos and images for canvas
printing in three easy steps. By resizing, fine-tuning, and
stretching the image, it's easy to achieve the perfect
composition for your wall art.

Border and Grommet dialog box: Core|DRAW
accelerates the workflow of production professionals
with the Border and Grommet dialog box, which
simplifies preparing banner designs for printing. It has
intuitive controls for precisely creating the perfect
border for the job, whether it's stretching or mirroring
the document edges or defining a color. This feature
also simplifies adding grommets, which are rings or
edge strips inserted into holes through thin material
used to insert ropes and properly hang a banner. The
Border and Grommet dialog box also gives you the
flexibility to create a banner from the entire active page
or just selected objects.

) Vo=
ARLAPIA

The Border and Grommet dialog box lets you create a banner
from a page or from selected objects on a page.
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Image opening options: So you can set up your
workspace in the way that best suits your style, Corel PHOTO-
PAINT offers options for how your photos open. You can have
a number of documents visible simultaneously in floating
windows. Or if you want to focus on one image at a time, files
can be opened in the default tabbed view.

Community website for developers: With support
from the Developer Community site, you can create your
own automation tools. There's a variety of useful resources,
including in-depth programming articles and code samples,
which can help you automate tasks with macros and create
custom features. And when you have questions, there's a
community forum, knowledge base, or the FAQ page.

For information, visit www.community.coreldraw.com/sdk.


http://www.community.coreldraw.com/sdk
http://www.community.coreldraw.com/sdk
http://www.community.coreldraw.com/sdk
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EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, WARRANTIES OF MERCHANTABLE QUALITY, SATISFACTORY
QUALITY, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, OR THOSE ARISING BY LAW, STATUTE,
USAGE OF TRADE, COURSE OF DEALING OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS OF THE
INFORMATION PROVIDED OR ITS USE IS ASSUMED BY YOU. COREL SHALL HAVE NO LIABILITY TO YOU OR ANY
OTHER PERSON OR ENTITY FOR ANY INDIRECT, INCIDENTAL, SPECIAL, OR CONSEQUENTIAL DAMAGES
WHATSOEVER, INCLUDING, BUT NOT LIMITED TO, LOSS OF REVENUE OR PROFIT, LOST OR DAMAGED DATA OR
OTHER COMMERCIAL OR ECONOMIC LOSS, EVEN [F COREL HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES, OR THEY ARE FORESEEABLE. COREL IS ALSO NOT LIABLE FOR ANY CLAIMS MADE BY ANY THIRD PARTY.
COREL'S MAXIMUM AGGREGATE LIABILITY TO YOU SHALL NOT EXCEED THE COSTS PAID BY YOU TO PURCHASE THE
MATERIALS. SOME STATES/COUNTRIES DO NOT ALLOW EXCLUSIONS OR LIMITATIONS OF LIABILITY FOR
CONSEQUENTIAL OR INCIDENTAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU.
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